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The goal of the Missouri S&T Publication Option templates for Word 2016 is to help you meet campus 

formatting criteria for your thesis or dissertation. This guide is meant to help aid you in fixing 

formatting problems commonly experienced in this template. For a complete list of S&T’s formatting 

rules and regulations, please refer to the Thesis & Dissertation Specifications (revised January 2018). 

The Word templates are located on the Office of Graduate Studies’ website, found at 
grad.mst.edu > Current Graduate Students > Thesis and Dissertation Information 

This guide will only cover formatting for the Publication Option template. 

2) GETTING STARTED 

Adding Text into the Document 
• Option 1: Write directly into the template. 

o You may delete the filler text within sections and replace it with your own words. You 

may also add new sections that are not included in the template. 

o When creating new sections, pressing Enter will automatically move you from Heading 1 

to Heading 2, and from Heading 2 to body text. 

o We recommend typing your headings before applying heading styles, but you can also 

apply styles before you start typing out the heading. 

• Option 2: Copy and paste your text directly into the template. 

o If you already have the text of your thesis or dissertation written in a separate Word file, 

you may copy text from that file and paste it directly into the body of the template. (You 

will most likely be doing this for your paper writing of the Publication Option.) 

o We recommend pasting text section by section rather than the full document all at 

once. 

o After pasting, go through your text and apply the correct styles, spacing, and paragraph 

indentation. 

• Important: Do not copy and paste from the template into a different document. The format will 

not remain the same. 

Styles 

https://grad.mst.edu/currentstudents/thesisdissertationinformation/formatting/
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The template is built around Word’s Styles functionality. These styles are used to define text and link 

to common formatting rules. For example, all 1st level headings within the body of your document 

should be set as Heading 1 to maintain correct formatting and numbering. These linked styles can 

then be used to generate the Table of Contents. 

The template contains all the styles you should need within your thesis or dissertation, and you should 

not need to modify their style definitions (keep in mind if you modify a style, it will change every 

instance of that style within your document). A full description of the template’s styles can be found in 

Section 4 of this guide. 

If you click inside any text within the template, the style it has been set to should be selected within 

the list of styles. To change to a different style, place your cursor inside the line of text you wish to 

change, and then click on the new style. By default, styles will change all text up to a carriage return. 

The Style Separator tool must be used to separate the first line of 3rd and 4th level headings, as shown 

in Section 7 of this guide. 

Show/Hide Button 
The Show/Hide button is located in the top right corner in 

the Paragraph group under the Home tab. 

Clicking on this button will show you nonprinting marks within your document such as section breaks, 

page breaks, paragraph breaks, line breaks, tabs, and spaces. 

This tool is extremely useful when working with your document’s format. If you are having formatting 
issues or are copying/pasting text, we recommend using this feature 

Example of the Show/Hide button revealing spaces, tabs, paragraph breaks, and a page break. 



5 

Page Breaks vs. Section Breaks 
When using the Word templates, it is vital to understand the difference between page breaks and 

section breaks: 

• Page break: starts a new page. Page breaks do not change the format between pages; they 

simply move your cursor down to the beginning of the next page. They can be found under the 

Insert or Layout tab. 

• Section break: creates two different sections before and after the break (i.e., allows you to 

change the format from one page to another). Section breaks are often used to change format 

of page numbers or to make a single page landscape. They can be found under the Layout tab. 

Section breaks can be used between pages (“Next Page” break) or between parts of a single 

page (“Continuous” break). 
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Accidentally deleting a section break within the template will usually cause formatting errors and can 

be difficult to correct. Before deleting text on a page, always turn on the Show/Hide button to make 

sure you are not also deleting a section break. 

If you are deleting a page with a section break, make sure there is still a section break on the bottom 

of the page that remains. For example, if you delete the Nomenclature page, make sure there is still a 

section break between the last page of your front matter and the first page of your introduction 

section. The exception is the flyleaf pages; these section breaks may be removed without issue. 

Automatic vs. Manual Formatting 
The template is built to automatically format your document to the thesis/dissertation specifications 

as much as possible. However, due to Word’s limitations, sometimes you will have to manually adjust 
the document’s formatting. The instructions in this guide will help you with the areas that need to be 

manually formatted. 

Below is a brief list of what the template automatically formats and what will need to be manually 

formatted. 
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Automatic Manual 

• Double line spacing 

• First-line paragraph indentation 

• Section and subsection numbering (after 

manually restarting in each paper) 

• Space below headings in front matter 

(Heading 0) 

• Extra space above 2nd level headings 

• Page numbers 

• List of headings and page numbers in TOC 

(after updating table) 

• Figure and table numbering 

• Equation numbering 

• Single-spacing and properly aligning multi-

lined 2nd level headings and headings in 

TOC 

• “SECTION” and “PAPER” labels in TOC 

• “APPENDICES” and lettering (“A,” “B,” etc.) 
written in TOC for multiple appendices 

• “SECTION” and “PAPER” labels in LI/LT 

• Capitalization of 1st level and 2nd level 

headings 

• Page break before 1st level headings 

(Heading 1) in section writing 

• Carriage return above 1st level headings in 

paper writing 

• Carriage return below 1st level headings 

when directly followed by body text 

• Style separator after 3rd and 4th level 

headings 
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3) GENERAL DOCUMENT INFORMATION 

• Flyleaves: This template has flyleaves, but these pages are optional. 

• Title page: You should not have to adjust the spacing on the title page at all. Just replace the 

filler text with your own information. 

• Placeholder text: Some sections of the template have Lorem ipsum placeholder text. This is just 

for a visual of what the document should look like. 

• Nomenclature: This page is optional. Instructions for linking to the nomenclature are written in 

Section 1.1.3. of the template. 

• Styles: All styles you need for the Publication Option are built into this template. Use these 

styles if you want to manually generate your TOC. You should not have to modify or add to 

these styles. Numbering should appear automatically. 

• 2nd level headings: The extra space above 2nd level headings is built in. You should not have to 

manually space above these headings more than any other paragraph break. 

• Spacing: Your document should be double spaced, with a few exceptions for long headings, 

captions, and references. A double-spaced line equals 24 pts of space. If you single-space a line 

for a heading, the line below it will no longer be fully double spaced. Therefore, you may have to 

add 12 pts of “After” paragraph spacing to maintain the look of double line spacing. This applies 

when single-spacing 1st and 2nd level headings and when inserting tables. 

• Indentation: The indentation of body paragraphs is built into “Style Body Text.” You may have to 

adjust this when working with 3rd and 4th level headings. 

• Tables/Figures: Note that the numbering system for tables and figures changes between section 

writing and paper writing, and the numbering restarts with each new paper. When writing table 

titles and figure captions, type out the title/caption first (including number, which won’t appear 
automatically) and then apply the appropriate setting under Styles (either “Figure Title” or 
“Table Title”). Do not use “Insert Caption” under the References tab. 

• Appendices: The Publication Option template shows formatting for multiple appendices. The 

traditional thesis template shows formatting for one appendix. 
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4) LIST OF STYLES 

Note that Heading 1, Heading 2, Heading 3, and Heading 4 are used for both section writing and paper 

writing. Any style that starts with “Paper” is exclusively used in the paper writing. 

• Appendix Title (1): if you only have one appendix, use this for the title under the heading 

“APPENDIX.” This title is optional. It will not appear in your TOC. 

• Appendix Title (2): if you have multiple appendices, use this only for the title on the appendices’ 

title pages. This title will link to your TOC. 

• HEADING 0: all headings in the front matter and back matter that appear in the TOC, and for the 

heading “APPENDIX” if you only have one appendix. 

• TOC Heading 1: only used for the “TABLE OF CONTENTS” heading to avoid having it appear 
within your TOC. 

• Heading 1: all 1st level headings in your section writing and paper writing, such as 

“INTRODUCTION” or “LITERATURE REVIEW.” This heading must be written in all caps. 

• Heading 2: all 2nd level headings. This heading must be written in all caps. 

• Heading 3 and 4: all 3rd level and 4th level headings. Note the proper capitalization of each 

heading. The body text of the following paragraph begins on the same line as these headings. 

• Style Body Text: body text with a first-line indentation. 

• Normal: body text without indentation. 

• Figure Title: all figure captions. This style is automatically single spaced. Use Normal style for 

figures within the appendices, as these are not listed in the TOC. 

• Table Title: all table titles. This style is automatically single spaced. Use Normal style for tables 

within the appendices, as these are not listed in the TOC. 

• Paper Abstract: for the heading “Abstract” within your paper writing. 

• Paper Authors: used if you list authors below the paper title and before “ABSTRACT” in your 

paper writing. 

• Paper Reference: for the heading “References” within your paper writing. 

• Paper Title: for your paper titles, with an uppercase Roman numeral. 
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• PAPER/SECTION Heading: can be used for the word “PAPER” and “SECTION” at the start of your 
papers and section conclusion. It will not link to the TOC. 
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5) TABLE OF CONTENTS/LI/LT 

Table of Contents 
If using styles appropriately, the TOC should generate with correct headings, indentation, and page 

numbers, but you will still need to make some manual modifications: 

• Write the word “SECTION” on a new line between front matter and section introduction 

• Write the word “PAPER” on a new line before your paper writing begins 

• Write the word “SECTION” on a new line after your paper writing and before your section 

conclusion 

• Single-space multi-lined headings and make sure text is properly aligned 

(see Section 11a) 

• Make sure punctuation after 3rd and 4th level headings is consistent 

• If you have multiple appendices, write in the word “APPENDICES” on a new line before the titles 

appear, and add in “A,” “B,” etc. before each title 
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List of Illustrations & List of Tables 
• Numbering style of figures and tables differs between the section writing and the paper writing. 

o Section Writing: Numbered like “Section.Figure” (e.g., Figure 1.1, 1.2, 3.1). 

o Paper Writing: Numbered consecutively without including section number (e.g., Figure 

1, Figure 2, Figure 3). Numbering restarts with each new paper. 

• Because the numbering style changes within the LI/LT, the figure and table numbers must be 

typed manually whenever you insert your captions. The text that appears in the LI/LT will be 

exactly what you typed into the caption. 

• Numbering of figures in your section conclusion continues where your section introduction 

numbering left off and will be placed below the figures in your paper writing. 
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• The labels “SECTION” and “PAPER #” must be added in manually. 

• Follow these instructions whenever you are ready to update your LI/LT: 

o Right-click anywhere in the LI or LT 

o Select Update Field 

o Select Update entire table 

o Press OK 

o Place your cursor to the right of the page number above the line where your label 

should be inserted 

o Press Enter 

o Type the appropriate label 

o Repeat inserting labels until all corresponding sections and papers are listed 

o Delete all text past the first period in all captions 

o Single-space captions that are more than one line long (see Section 11a) 



14 

o Remove any figures or tables that appear in your appendices 

• You may instead format your LI/LT with “Figure” written as a column heading instead of beside 

each caption. 
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6) FORMATTING 1ST LEVEL HEADINGS 

Section Writing and Paper Writing 
• Section writing: 1st level headings should start on a new page (just like in the traditional 

theses/dissertations). To do this, insert a Page Break before the 1st level heading. 

• Paper writing: 1st level headings can start on the same page as the text before them. 

o Press Enter twice after the previous paragraph 

o Type out heading title in all caps and set to Heading 1 

o Press Enter once to move automatically to Heading 2 

o If you want text before Heading 2, change the style to Style Body Text instead of 
Heading 2, press Enter once, and begin typing your paragraph 

Restarting Heading Numbering 
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• Paper Writing: you will need to restart the numbering of the first 1st level heading that appears. 
The rest of the numbering within that paper should follow automatically. 

o Right-click Heading 1 number 

o Choose Restart at 1 

• Section Writing: The heading number corresponding to your section writing conclusion should 

pick up where the section writing introduction stopped. 

o Check your section writing introduction for the number of the last 1st level heading 

o Scroll down to your section writing conclusion and right-click the number to the left of 
Heading 1 

o Choose Set Numbering Value 

o Type in the correct heading number in the box under “Set value to” 
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o Press OK 
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7) FORMATTING 3RD AND 4TH LEVEL HEADINGS 

Since Word automatically treats everything up to a hard return (i.e., paragraph break) as a single style, 

you must manually adjust 3rd and 4th level headings in order for the beginning of your body text to 

begin on the same line. Using the Style Separator tool is recommended because it will only pull the 

actual heading into the TOC. 

• Click the down arrow on your Quick Access Toolbar and select More Commands 

• Select All Commands from the drop-down menu 

• Scroll down and select Style Separator 

• Press Add and then OK 
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• In your document, type your 3rd level heading on a line by itself with the body text in a 

paragraph underneath it (not beside it) 

• Mark the heading as Heading 3 in the Styles menu 

• With your cursor within the text of your heading, click the Style Separator tool in the Quick 

Access toolbar (or press Alt + Ctrl + Return). Your body text should be moved up to the same 

line as Heading 3 and maintain the correct style 
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8) FORMATTING PAPER WRITING 

• “PAPER” must be written above the first paper’s title (but not subsequent papers). 

• Paper authors are optional. If included, you must insert a carriage return in the line above the 

authors. 

• Headings do not start on a new page (other than the paper title). 

• Section breaks are not necessary. 
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9) INSERTING FIGURES AND TABLES 

Tables and figures must have equal space above and below. Table titles go above tables, and figure 

captions go below figures. Follow the steps in this section to ensure your tables and figures have the 

right amount of space around them. 

Please note that due to the nature of figure numbering within the Publication Option specifications 

(i.e., numbering restarts with each new paper), the Publication Option template does not support 

automatic numbering of figures and tables. 

For Figures: 
• Hit Enter twice after your body text 

• Insert your figure (make sure it does not go past your page margins) 

• Hit Enter once 

• Type out the figure label, number, and caption below your figure 

• Mark your caption as Figure Title under Styles 

• Hit Enter twice before returning to your body text 

Example of correctly formatted figure. 
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For Tables: 
• Hit Enter twice after your body text wherever you want to insert the table 

• Under the References tab, click on  Insert Caption 

• Make sure Label is set to Table, and then press OK 

• Space once beside the table number and type out your table title 

• Make sure your full caption is marked as Caption under Styles 

• Hit Enter once and then insert your table 

• Click into the empty space below the table (this should be there automatically; if not, insert a 

carriage return below the table) 

• With your cursor in the empty space below the table, insert 12 pt “After” paragraph spacing 

Example of correctly formatted table. 
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10) INSERTING REFERENCES AND 

BIBLIOGRAPHY 

Double spacing should be used between each reference. References that are more than one line long 

should be single-spaced within. 

References can be formatted alphabetically (with hanging indent) or numerically. Students may use the 

citation style recommended by their department, or otherwise use whichever style best suits their area 

of study. APA and IEEE are commonly used at Missouri S&T. 

Different citation styles may be used per paper in the Publication Option (e.g., Paper I may use APA 

citation style while Paper II uses IEEE.) 

• References: Each paper in the paper writing will have its own unique set of references. These 

are the references that were published alongside that individual paper. Just copy and paste your 

paper’s references into this section, and then format appropriately. 

• Bibliography: Any citations used in your section writing (introduction and conclusion) will be 

listed here. You may use citation management software like Mendeley to build this bibliography, 

but note that Mendeley does not support multiple reference lists, so it cannot be used for the 

lists of references within your paper writing. If you do not have citations in your section writing, 

remove this page. 

• Formatting: You may be able to paste references as Merge Formatting without any issue. 

However, formatting references can be time-consuming if they are pasted as entirely double 

spaced or single spaced. The following directions are the easiest way to meet formatting 

requirements: 

o Paste references 
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o Highlight all references in list 

o Change to single line spacing 

o Under Layout, add 15 pt “After” paragraph spacing 

o Apply hanging indent (if applicable): 

▪ Make sure all references are highlighted 

▪ Click the dialog box launcher in the lower right corner of the Paragraph group 

▪ Under Indentation, change “Special” to Hanging 

o Check that none of your references are split between two pages 
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11) SINGLE-SPACING A MULTI-LINED HEADING 

In the TOC: 
• Highlight everything within the TOC 

• Change to single spacing 

• Add 15 pt of “After” paragraph spacing 

• Make sure no entries are split between two pages 

• If any text encroaches page number, press Shift + Enter (a soft carriage return) to move that text 

to the next line 

• 

Example of heading encroaching page number area 

Text moved to next line with soft carriage returns 

• Use ruler to ensure subsequent lines of heading are properly aligned 
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In a 2nd level heading: 
• Change entire heading to single spacing (no paragraph breaks needed) 

• Place cursor at the end of heading 

• Add 12 pt of “After” paragraph spacing (located under the Layout tab or in the Paragraph dialog 

box) 

References 
• Highlight all references 

• Change to single spacing 

• Add 15 pt of “After” paragraph spacing 

• Apply hanging indent (if applicable) 

o Make sure all references are highlighted 

o Click the dialog box launcher in the lower right corner of the Paragraph group 

o Under Indentation, change “Special” to Hanging 

• Make sure no references are split between two pages 
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12) TOO MUCH SPACE ABOVE HEADINGS 

If your 3rd and 4th level headings are jumping down to the next page and leaving large gaps of space 

above them, you are probably using an earlier version of the templates. Follow the steps in this 

section to correct this issue. 

• Right-click the Heading 3 style 

• Select Modify 
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• Select Format in the lower right-hand corner of the dialog box 

• Choose Paragraph from the menu 

• Select the Line and Page Breaks tab 

• Deselect Keep with next and Keep lines together 

(Widow/Orphan control should be the only option selected) 
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13) APPENDIX HEADING STYLES 

For One Appendix: 
• Use Heading 0 for the word “APPENDIX,” which will link to your TOC. 

• Use Appendix Title (1) for the title under “APPENDIX.” This title is optional. It will not appear in 

your TOC. 

For Multiple Appendices: 
• Use Normal for the first line on appendix title page (e.g., “APPENDIX B”). 

• Use Appendix Title (2) for the title on the appendices’ title pages. This title will link to your TOC. 

• In your TOC, type in the word “APPENDICES” on a new line before your appendix titles, and add 
the corresponding letter (e.g., “A” and “B”) to the left of each appendix title. 
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14) OTHER RECOMMENDATIONS 

• TOC page numbers: After updating the TOC and taking away extra words from 3rd and 4th level 

headings, always finish by “Updating Page Numbers Only.” 

• Spacing around figures/equations: You may have to manually adjust spacing around your 

figures and equations to make it look equal above and below, especially if your figure contains a 

lot of white space around the edges of the image. 

• Hiding page numbers: If you need to hide a page number, the easiest way is to place a white 

box over it with no border. Just check to make sure it’s still there if your pages get shifted 

around. 

• Automatically updated styles: If you make a local change to a style and find that the change 

syncs with your other text, right-click that style, select “Modify,” and deselect “Automatically 

Update” to prevent this from happening. 

• Spell check: Go to File > Options > Proofing and make sure “Ignore words in UPPERCASE” is not 

selected. Otherwise, Word will not catch misspellings within your major level headings. 

• Heading capitalization: You can use the “Change Case” option in the Font group to quickly put 
text in all caps, and this should appear in your TOC. 

• Landscape pages: It is easier to turn a figure sideways than to turn a page landscape. If using a 

table, you will need to insert it into a text box in order to turn it sideways. Make sure to keep 

the same margins as your other pages. If turning a page landscape, follow instructions in 

Appendix B for modifying page numbers. 

• Blurry Heading Numbers: Sometimes when converting to PDF, your heading numbers or text 

will appear blurry. This seems to happen more frequently if you are using an outdated version of 

the template or a version of Office older than 2016. If this happens, highlight your heading 

numbers and press Ctrl + spacebar. If the problem persists, open a new copy of the template 

and use the Format Painter tool to copy the correct format from the template’s headings onto 
the blurry heading in your document. 
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